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1 Foreword

1.1 Notes on the documentation
Intended audience

This description is only intended for the use of trained specialists in control and automation engineering who
are familiar with the applicable national standards.
It is essential that the documentation and the following notes and explanations are followed when installing
and commissioning these components.
It is the duty of the technical personnel to use the documentation published at the respective time of each
installation and commissioning.

The responsible staff must ensure that the application or use of the products described satisfy all the
requirements for safety, including all the relevant laws, regulations, guidelines and standards.

Disclaimer

The documentation has been prepared with care. The products described are, however, constantly under
development.

We reserve the right to revise and change the documentation at any time and without prior announcement.

No claims for the modification of products that have already been supplied may be made on the basis of the
data, diagrams and descriptions in this documentation.

Trademarks

Beckhoff®, TwinCAT®, TwinCAT/BSD®, TC/BSD®, EtherCAT®, EtherCAT G®, EtherCAT G10®, EtherCAT P®,
Safety over EtherCAT®, TwinSAFE®, XFC®, XTS® and XPlanar® are registered trademarks of and licensed by
Beckhoff Automation GmbH. Other designations used in this publication may be trademarks whose use by
third parties for their own purposes could violate the rights of the owners.

Patent Pending

The EtherCAT Technology is covered, including but not limited to the following patent applications and
patents: EP1590927, EP1789857, EP1456722, EP2137893, DE102015105702 with corresponding
applications or registrations in various other countries.

EtherCAT® is registered trademark and patented technology, licensed by Beckhoff Automation GmbH,
Germany.

Copyright

© Beckhoff Automation GmbH & Co. KG, Germany.
The reproduction, distribution and utilization of this document as well as the communication of its contents to
others without express authorization are prohibited.
Offenders will be held liable for the payment of damages. All rights reserved in the event of the grant of a
patent, utility model or design.
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1.2 Guide through documentation
NOTICE

Further components of documentation
This documentation describes device-specific content. It is part of the modular
documentation concept for Beckhoff I/O components. For the use and safe operation of the
device / devices described in this documentation, additional cross-product descriptions are
required, which can be found in the following table.

Title Description
EtherCAT System Documentation (PDF) • System overview

• EtherCAT basics
• Cable redundancy
• Hot Connect
• EtherCAT devices configuration

Infrastructure for EtherCAT/Ethernet (PDF) Technical recommendations and notes for design,
implementation and testing

Software Declarations I/O (PDF) Open source software declarations for
Beckhoff I/O components

The documentations can be viewed at and downloaded from the Beckhoff website (www.beckhoff.com) via:

• the “Documentation and Download” area of the respective product page,

• the Download finder,

• the Beckhoff Information System.

https://www.beckhoff.com/en-us/download/96209514
https://www.beckhoff.com/en-us/download/58769146
https://www.beckhoff.com/en-us/download/628288677
http://www.beckhoff.com/
https://www.beckhoff.com/en-us/support/download-finder/technical-documentations/
https://infosys.beckhoff.com/content/1033/fieldbusinfosys/index.html?id=4211986674403809096
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1.3 Safety instructions
Safety regulations

Please note the following safety instructions and explanations!
Product-specific safety instructions can be found on following pages or in the areas mounting, wiring,
commissioning etc.

Exclusion of liability

All the components are supplied in particular hardware and software configurations appropriate for the
application. Modifications to hardware or software configurations other than those described in the
documentation are not permitted, and nullify the liability of Beckhoff Automation GmbH & Co. KG.

Personnel qualification

This description is only intended for trained specialists in control, automation and drive engineering who are
familiar with the applicable national standards.

Description of instructions

In this documentation the following instructions are used. 
These instructions must be read carefully and followed without fail!

 DANGER
Serious risk of injury!
Failure to follow this safety instruction directly endangers the life and health of persons.

 WARNING
Risk of injury!
Failure to follow this safety instruction endangers the life and health of persons.

 CAUTION
Personal injuries!
Failure to follow this safety instruction can lead to injuries to persons.

NOTICE
Damage to environment/equipment or data loss
Failure to follow this instruction can lead to environmental damage, equipment damage or data loss.

Tip or pointer
This symbol indicates information that contributes to better understanding.
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1.4 Documentation issue status
Version Comment
3.1 • Update chapter "Technical data"

• Update Firmware and Hardware versions
• Update structure

3.0 • New title
• Update chapter "Technical data"
• Update Firmware and Hardware versions
• Update structure

2.1.0 • Update chapter "Notes on the documentation"
• Update chapter "Instructions for ESD protection"
• Update Firmware and Hardware versions
• Update structure
• EL95xx removed

2.0.0 • Migration
• Update structure

1.1.0 • Correction chapter "Technical data"
1.0.0 • First published

Firmware and hardware versions

Documentation, version Firmware version Hardware version
3.1 00 08
3.0 00 08
2.1.0 00 06
1.1.0 00 01
1.0.0 00 00

The firmware and hardware versions (delivery state) can be taken from the serial number [} 10] printed on
the side of the terminal module.
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1.5 Version identification of EtherCAT devices

1.5.1 General notes on marking

Designation

A Beckhoff EtherCAT device has a 14-digit designation, made up of

• family key
• type
• version
• revision

Example Family Type Version Revision
EL3314-0000-0016 EL terminal

12 mm, non-pluggable connection level
3314
4-channel thermocouple terminal

0000
basic type

0016

ES3602-0010-0017 ES terminal
12 mm, pluggable connection level

3602
2-channel voltage measurement

0010
high-precision version

0017

CU2008-0000-0000 CU device 2008
8-port fast ethernet switch

0000
basic type

0000

Notes
• The elements mentioned above result in the technical designation. EL3314-0000-0016 is used in the

example below.
• EL3314-0000 is the order identifier, in the case of “-0000” usually abbreviated to EL3314. “-0016” is the

EtherCAT revision.
• The order identifier is made up of

- family key (EL, EP, CU, ES, KL, CX, etc.)
- type (3314)
- version (-0000)

• The revision -0016 shows the technical progress, such as the extension of features with regard to the
EtherCAT communication, and is managed by Beckhoff.
In principle, a device with a higher revision can replace a device with a lower revision, unless specified
otherwise, e.g. in the documentation.
Associated and synonymous with each revision there is usually a description (ESI, EtherCAT Slave
Information) in the form of an XML file, which is available for download from the Beckhoff web site. 
From 2014/01 the revision is shown on the outside of the IP20 terminals, see Fig. “EL5021 EL terminal,
standard IP20 IO device with batch number and revision ID (since 2014/01)”.

• The type, version and revision are read as decimal numbers, even if they are technically saved in
hexadecimal.
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1.5.2 Version identification of EM modules
The serial number/ data code for Beckhoff IO devices is usually the 8-digit number printed on the device or
on a sticker. The serial number indicates the configuration in delivery state and therefore refers to a whole
production batch, without distinguishing the individual modules of a batch.

Structure of the serial number: KK YY FF HH
KK - week of production (CW, calendar week)
YY - year of production
FF - firmware version
HH - hardware version

Example with serial number 12 06 3A 02:
12 - production week 12
06 - production year 2006
3A - firmware version 3A
02 - hardware version 02

Fig. 1: EM2042 with revision 0000 and serial number 20190212
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1.5.3 Beckhoff Identification Code (BIC)
The Beckhoff Identification Code (BIC) is increasingly being applied to Beckhoff products to uniquely identify
the product. The BIC is represented as a Data Matrix Code (DMC, code scheme ECC200), the content is
based on the ANSI standard MH10.8.2-2016.

Fig. 2: BIC as data matrix code (DMC, code scheme ECC200)

The BIC will be introduced step by step across all product groups.

Depending on the product, it can be found in the following places:

• on the packaging unit
• directly on the product (if space suffices)
• on the packaging unit and the product

The BIC is machine-readable and contains information that can also be used by the customer for handling
and product management.

Each piece of information can be uniquely identified using the so-called data identifier
(ANSI MH10.8.2-2016). The data identifier is followed by a character string. Both together have a maximum
length according to the table below. If the information is shorter, spaces are added to it.

Following information is possible, positions 1 to 4 are always present, the other according to need of
production:
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Posi-
tion

Type of
information

Explanation Data
identifier

Number of digits
incl. data identifier

Example

1 Beckhoff order
number

Beckhoff order number 1P 8 1P072222

2 Beckhoff Traceability
Number (BTN)

Unique serial number,
see note below

SBTN 12 SBTNk4p562d7

3 Article description Beckhoff article
description, e.g.
EL1008

1K 32 1KEL1809

4 Quantity Quantity in packaging
unit, e.g. 1, 10, etc.

Q 6 Q1

5 Batch number Optional: Year and week
of production

2P 14 2P401503180016

6 ID/serial number Optional: Present-day
serial number system,
e.g. with safety products

51S 12 51S678294

7 Variant number Optional: Product variant
number on the basis of
standard products

30P 32 30PF971, 2*K183

...

Further types of information and data identifiers are used by Beckhoff and serve internal processes.

Structure of the BIC

Example of composite information from positions 1 to 4 and with the above given example value on position
6. The data identifiers are highlighted in bold font:

1P072222SBTNk4p562d71KEL1809 Q1 51S678294

Accordingly as DMC:

Fig. 3: Example DMC 1P072222SBTNk4p562d71KEL1809 Q1 51S678294

BTN

An important component of the BIC is the Beckhoff Traceability Number (BTN, position 2). The BTN is a
unique serial number consisting of eight characters that will replace all other serial number systems at
Beckhoff in the long term (e.g. batch designations on IO components, previous serial number range for
safety products, etc.). The BTN will also be introduced step by step, so it may happen that the BTN is not yet
coded in the BIC.

NOTICE
This information has been carefully prepared. However, the procedure described is constantly being further
developed. We reserve the right to revise and change procedures and documentation at any time and
without prior notice. No claims for changes can be made from the information, illustrations and descriptions
in this information.
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1.5.4 Electronic access to the BIC (eBIC)

Electronic BIC (eBIC)

The Beckhoff Identification Code (BIC) is applied to the outside of Beckhoff products in a visible place. If
possible, it should also be electronically readable.

Decisive for the electronic readout is the interface via which the product can be electronically addressed.

K-bus devices (IP20, IP67)

Currently, no electronic storage and readout is planned for these devices.

EtherCAT devices (IP20, IP67)

All Beckhoff EtherCAT devices have a so-called ESI-EEPROM, which contains the EtherCAT identity with
the revision number. Stored in it is the EtherCAT slave information, also colloquially known as ESI/XML
configuration file for the EtherCAT master. See the corresponding chapter in the EtherCAT system manual
(Link) for the relationships.

The eBIC is also stored in the ESI‑EEPROM. The eBIC was introduced into the Beckhoff I/O production
(terminals, box modules) from 2020; widespread implementation is expected in 2021.

The user can electronically access the eBIC (if existent) as follows:

• With all EtherCAT devices, the EtherCAT master (TwinCAT) can read the eBIC from the ESI‑EEPROM
◦ From TwinCAT 3.1 build 4024.11, the eBIC can be displayed in the online view.
◦ To do this,

check the checkbox "Show Beckhoff Identification Code (BIC)" under
EtherCAT → Advanced Settings → Diagnostics:

◦ The BTN and its contents are then displayed:

◦ Note: as can be seen in the illustration, the production data HW version, FW version and
production date, which have been programmed since 2012, can also be displayed with "Show
Production Info".

◦ From TwinCAT 3.1. build 4024.24 the functions FB_EcReadBIC and FB_EcReadBTN for reading
into the PLC and further eBIC auxiliary functions are available in the Tc2_EtherCAT Library from
v3.3.19.0.

• In the case of EtherCAT devices with CoE directory, the object 0x10E2:01 can additionally by used to
display the device's own eBIC; the PLC can also simply access the information here:

https://infosys.beckhoff.com/content/1033/ethercatsystem/2469086859.html
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◦ The device must be in PREOP/SAFEOP/OP for access:

◦ the object 0x10E2 will be introduced into stock products in the course of a necessary firmware
revision.

◦ From TwinCAT 3.1. build 4024.24 the functions FB_EcCoEReadBIC and FB_EcCoEReadBTN for
reading into the PLC and further eBIC auxiliary functions are available in the Tc2_EtherCAT
Library from v3.3.19.0.

• Note: in the case of electronic further processing, the BTN is to be handled as a string(8); the identifier
"SBTN" is not part of the BTN.

• Technical background
The new BIC information is additionally written as a category in the ESI‑EEPROM during the device
production. The structure of the ESI content is largely dictated by the ETG specifications, therefore the
additional vendor-specific content is stored with the help of a category according to ETG.2010. ID 03
indicates to all EtherCAT masters that they must not overwrite these data in case of an update or
restore the data after an ESI update. 
The structure follows the content of the BIC, see there. This results in a memory requirement of
approx. 50..200 bytes in the EEPROM.

• Special cases
◦ If multiple, hierarchically arranged ESCs are installed in a device, only the top-level ESC carries

the eBIC Information.
◦ If multiple, non-hierarchically arranged ESCs are installed in a device, all ESCs carry the eBIC

Information.
◦ If the device consists of several sub-devices with their own identity, but only the top-level device is

accessible via EtherCAT, the eBIC of the top-level device is located in the CoE object directory
0x10E2:01 and the eBICs of the sub-devices follow in 0x10E2:nn.

PROFIBUS, PROFINET, DeviceNet devices etc.

Currently, no electronic storage and readout is planned for these devices.



Product overview

EM2042 15Version: 3.1

2 Product overview

2.1 Introduction

Fig. 4: EM2042

The EM2042 EtherCAT Module combines 16 digital outputs in a compact D-sub connector and is therefore
ideally suited for valve terminals with multi-pin plug connection.

The binary control signals are transferred (electrically isolated) to the actuators at the process level. The
EM2042 is integrated into the I/O system like standard EtherCAT Terminals. The X2 connector [} 23] for the
power supply is included in the scope of supply.
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2.2 Technical data
Technical data EM2042
Connection technology D-sub
Number of outputs 16
Rated load voltage 24 VDC (-15 %/+20 %)
Load type ohmic, inductive, lamp load
Output current max. 0,5 A each channel, individually short-circuit

proof, total current max. 4 A
Short circuit current 0.6 A…1.0 A
Breaking energy (ind.) < 150  mJ/channel
Switching times TON: typically 60 µs

TOFF: typically 300 µs
Electrical isolation 500 V (E-bus/field voltage)
Power supply for the electronics via the E-bus
Current consumption X2 typ. 25 mA + load
Current consumption via E-bus typ. 115 mA
Data width in the input process image 0 bit
Data width in the output process image 16 bit
Dimensions [} 21] (W x H x D) approx. 26.5 mm x 100 mm x 51 mm, 

without wiring and connector Power supply
(width aligned: 24 mm)

Weight approx. 90 g
Permissible ambient temperature range during
operation

0°C ... + 55°C

Permissible ambient temperature range during
storage

-25°C ... + 85°C

Permissible relative humidity 95 %, no condensation
Mounting [} 19] on a 35 mm mounting rail [} 18] (e.g. mounting rail

TH 35-7.5 conforming to EN 60715)
Vibration/shock resistance conforms to EN 60068-2-6 / EN 60068-2-27
EMC immunity/emission conforms to EN 61000-6-2 / EN 61000-6-4,

EN 300-440-02
Protection class IP20
Installation position variable
Marking / Approval*) CE, EAC, UKCA

*) Real applicable approvals/markings see type plate on the side (product marking).
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3 Mounting and wiring

3.1 Instructions for ESD protection
NOTICE

Destruction of the devices by electrostatic discharge possible!
The devices contain components at risk from electrostatic discharge caused by improper handling.
• Please ensure you are electrostatically discharged and avoid touching the contacts of the device directly.
• Avoid contact with highly insulating materials (synthetic fibers, plastic film etc.).
• Surroundings (working place, packaging and personnel) should by grounded probably, when handling

with the devices.

• Each assembly must be terminated at the right hand end with an EL9011 or EL9012 bus end cap, to
ensure the protection class and ESD protection.

Fig. 5: Spring contacts of the Beckhoff I/O components

http://www.beckhoff.com/EL9011
http://www.beckhoff.com/EL9012
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3.2 Recommended mounting rails
Terminal Modules and EtherCAT Modules of KMxxxx and EMxxxx series, same as the terminals of the
EL66xx and EL67xx series can be snapped onto the following recommended mounting rails:

• mounting rail TH 35-7.5 with 1 mm material thickness (according to EN 60715)
• mounting rail TH 35-15 with 1.5 mm material thickness

Pay attention to the material thickness of the mounting rail
Terminal Modules and EtherCAT Modules of KMxxxx and EMxxxx series, same as the terminals of
the EL66xx and EL67xx series does not fit to the mounting rail TH 35-15 with 2.2 to 2.5 mm material
thickness (according to EN 60715)!
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3.3 Mounting and demounting - terminals with front
unlocking

The terminal modules are fastened to the assembly surface with the aid of a 35 mm mounting rail (e.g.
mounting rail TH 35-15).

Fixing of mounting rails
The locking mechanism of the terminals and couplers extends to the profile of the mounting rail. At
the installation, the locking mechanism of the components must not come into conflict with the fixing
bolts of the mounting rail. To mount the recommended mounting rails under the terminals and
couplers, you should use flat mounting connections (e.g. countersunk screws or blind rivets).

 WARNING
Risk of electric shock and damage of device!
Bring the bus terminal system into a safe, powered down state before starting installation, disassembly or
wiring of the Bus Terminals!

Mounting
• Fit the mounting rail to the planned assembly location.

 
and press (1) the terminal module against the mounting rail until it latches in place on the mounting
rail (2).

• Attach the cables.

Demounting
• Remove all the cables.
• Lever the unlatching hook back with thumb and forefinger (3). An internal mechanism pulls the two

latching lugs (3a) from the top hat rail back into the terminal module.
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• Pull (4) the terminal module away from the mounting surface. 
Avoid canting of the module; you should stabilize the module with the other hand, if required.
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3.4 Dimensions
 

Fig. 6: EM2042 Dimensions
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3.5 Positioning of passive Terminals
Hint for positioning of passive terminals in the bus terminal block
EtherCAT Terminals (ELxxxx / ESxxxx), which do not take an active part in data transfer within the
bus terminal block are so called passive terminals. The passive terminals have no current
consumption out of the E-Bus. 
To ensure an optimal data transfer, you must not directly string together more than two passive
terminals!

Examples for positioning of passive terminals (highlighted)

Fig. 7: Correct positioning

Fig. 8: Incorrect positioning
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3.6 Connection

Fig. 9: EM2042

X1: Signal connection, digital outputs, D-Sub 25

The EM2042 digital output module transmits the binary control signals from the automation unit on to the
actuators at the process level.

The 16 outputs deliver load currents of up to 0.5 A, although the total current from all the outputs must not
exceed 4 A.

The signal connection is made through a 25-pin D-Sub socket.

The outputs are short-circuit proof and protected against inverse connection.
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Fig. 10: D-Sub 25 - signal connection, digital outputs

X2: Connection of the supply voltage for the outputs, clamp connector 2-pole

Name Description
24 V Supply voltage 24 V
0 V Supply voltage 0 V

Fig. 11: Clamp connector X2, connection of the supply voltage for the outputs
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3.7 Note - Power supply
 WARNING

Power supply from SELV/PELV power supply unit!
SELV/PELV circuits (Safety Extra Low Voltage, Protective Extra Low Voltage) according to
IEC 61010-2-201 must be used to supply this device.
Notes:
• SELV/PELV circuits may give rise to further requirements from standards such as IEC 60204-1 et al, for

example with regard to cable spacing and insulation.
• A SELV (Safety Extra Low Voltage) supply provides safe electrical isolation and limitation of the voltage

without a connection to the protective conductor,
a PELV (Protective Extra Low Voltage) supply also requires a safe connection to the protective
conductor.
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3.8 Disposal
Products marked with a crossed-out wheeled bin shall not be discarded
with the normal waste stream. The device is considered as waste
electrical and electronic equipment. The national regulations for the
disposal of waste electrical and electronic equipment must be observed.
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4 Commissioning

4.1 TwinCAT Quick Start
TwinCAT is a development environment for real-time control including a multi PLC system, NC axis control,
programming and operation. The whole system is mapped through this environment and enables access to a
programming environment (including compilation) for the controller. Individual digital or analog inputs or
outputs can also be read or written directly, in order to verify their functionality, for example.

For further information, please refer to http://infosys.beckhoff.com:

• EtherCAT System Manual:
Fieldbus Components → EtherCAT Terminals → EtherCAT System Documentation → Setup in the
TwinCAT System Manager

• TwinCAT 2 → TwinCAT System Manager → I/O Configuration
• In particular, for TwinCAT – driver installation:

Fieldbus components → Fieldbus Cards and Switches → FC900x – PCI Cards for Ethernet →
Installation

Devices contain the relevant terminals for the actual configuration. All configuration data can be entered
directly via editor functions (offline) or via the `scan function (online):

• “offline”: The configuration can be customized by adding and positioning individual components.
These can be selected from a directory and configured.

◦ The procedure for the offline mode can be found under http://infosys.beckhoff.com:
TwinCAT 2 → TwinCAT System Manager → IO Configuration → Add an I/O device

• “online”: The existing hardware configuration is read

◦ See also http://infosys.beckhoff.com:
Fieldbus components → Fieldbus Cards and Switches → FC900x – PCI Cards for Ethernet →
Installation → Searching for devices

The following relationship is envisaged between the user PC and individual control elements:

http://infosys.beckhoff.com
http://infosys.beckhoff.com
http://infosys.beckhoff.com
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Fig. 12: Relationship between user side (commissioning) and installation

Insertion of certain components (I/O device, terminal, box...) by users functions the same way as in
TwinCAT 2 and TwinCAT 3. The descriptions below relate solely to the online procedure.

Example configuration (actual configuration)

Based on the following example configuration, the subsequent subsections describe the procedure for
TwinCAT 2 and TwinCAT 3:

• CX2040 control system (PLC) including CX2100-0004 power supply unit
• Connected to CX2040 on the right (E-bus):

EL1004 (4-channel digital input terminal 24 VDC)
• Linked via the X001 port (RJ-45): EK1100 EtherCAT Coupler
• Connected to the EK1100 EtherCAT Coupler on the right (E-bus):

EL2008 (8-channel digital output terminal 24 VDC; 0.5 A)
• (Optional via X000: a link to an external PC for the user interface)
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Fig. 13: Control configuration with Embedded PC, input (EL1004) and output (EL2008)

Note that all combinations of a configuration are possible; for example, the EL1004 terminal could also be
connected after the coupler, or the EL2008 terminal could additionally be connected to the CX2040 on the
right, in which case the EK1100 coupler wouldn’t be necessary.
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4.1.1 TwinCAT 2

Startup

TwinCAT 2 basically uses two user interfaces: the TwinCAT System Manager for communication with the
electromechanical components and TwinCAT PLC Control for the development and compilation of a
controller. The starting point is the TwinCAT System Manager.

After successful installation of the TwinCAT system on the PC to be used for development, the TwinCAT 2
System Manager displays the following user interface after startup:

Fig. 14: Initial TwinCAT 2 user interface

Generally, TwinCAT can be used in local or remote mode. Once the TwinCAT system, including the user
interface (standard) is installed on the respective PLC, TwinCAT can be used in local mode and thus the
next step is “Insert Device [} 32]”.

If the intention is to address the TwinCAT runtime environment installed on a PLC remotely from another
system used as a development environment, the target system must be made known first. In the menu under

“Actions” → “Choose Target System...”, the following window is opened for this via the symbol “ ” or the
“F8” key:
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Fig. 15: Selection of the target system

Use “Search (Ethernet)...” to enter the target system. Thus another dialog opens to either:

• enter the known computer name after “Enter Host Name / IP:” (as shown in red)
• perform a “Broadcast Search” (if the exact computer name is not known)
• enter the known computer – IP or AmsNetID

Fig. 16: specify the PLC for access by the TwinCAT System Manager: selection of the target system

Once the target system has been entered, it is available for selection as follows (a correct password may
have to be entered before this):

After confirmation with “OK”, the target system can be accessed via the System Manager.
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Adding devices

In the configuration tree of the TwinCAT 2 System Manager user interface on the left, select “I/O Devices”
and then right-click to open a context menu and select “Scan Devices…”, or start the action in the menu bar

via . The TwinCAT System Manager may first have to be set to “Config Mode” via  or via the
menu
“Actions” → “Set/Reset TwinCAT to Config Mode…” (Shift + F4).

Fig. 17: Select “Scan Devices...”

Confirm the warning message, which follows, and select the “EtherCAT” devices in the dialog:

Fig. 18: Automatic detection of I/O devices: selection of the devices to be integrated

Confirm the message “Find new boxes”, in order to determine the terminals connected to the devices. “Free
Run” enables manipulation of input and output values in “Config Mode” and should also be acknowledged.

Based on the example configuration [} 28] described at the beginning of this section, the result is as follows:
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Fig. 19: Mapping of the configuration in the TwinCAT 2 System Manager

The whole process consists of two stages, which can also be performed separately (first determine the
devices, then determine the connected elements such as boxes, terminals, etc.). A scan (search function)
can also be initiated by selecting “Device ...” from the context menu, which then only reads the elements
below which are present in the configuration:

Fig. 20: Reading of individual terminals connected to a device

This functionality is useful if the actual configuration is modified at short notice.

Programming and integrating the PLC

TwinCAT PLC Control is the development environment for generating the controller in different program
environments: TwinCAT PLC Control supports all languages described in IEC 61131-3. There are two text-
based languages and three graphical languages.

• Text-based languages
◦ Instruction List (IL)
◦ Structured Text (ST)



Commissioning

EM204234 Version: 3.1

• Graphical languages
◦ Function Block Diagram (FBD)
◦ Ladder Diagram (LD)
◦ The Continuous Function Chart Editor (CFC)
◦ Sequential Function Chart (SFC)

The following section refers solely to Structured Text (ST).

After starting TwinCAT PLC Control, the following user interface is shown for an initial project:

Fig. 21: TwinCAT PLC Control after startup

Example variables and an example program have been created and stored under the name
“PLC_example.pro”:
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Fig. 22: Example program with variables after a compile process (without variable integration)

Warning 1990 (missing “VAR_CONFIG”) after a compile process indicates that the variables defined as
external (with the ID “AT%I*” or “AT%Q*”) have not been assigned. After successful compilation, TwinCAT
PLC Control creates a “*.tpy” file in the directory in which the project was stored. This file (“*.tpy”) contains
variable assignments and is not known to the System Manager, hence the warning. Once the System
Manager has been notified, the warning no longer appears.

First, integrate the TwinCAT PLC Control project in the System Manager. This is performed via the context
menu of the PLC configuration (right-click) and selecting “Append PLC Project…”:

Fig. 23: Appending the TwinCAT PLC Control project
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Select the PLC configuration “PLC_example.tpy” in the browser window that opens. The project including the
two variables identified with “AT” are then integrated in the configuration tree of the System Manager:

Fig. 24: PLC project integrated in the PLC configuration of the System Manager

The two variables “bEL1004_Ch4” and “nEL2008_value” can now be assigned to certain process objects of
the I/O configuration.

Assigning variables

Open a window for selecting a suitable process object (PDO) via the context menu of a variable of the
integrated project “PLC_example” and via “Modify Link...” “Standard”:

Fig. 25: Creating the links between PLC variables and process objects

In the window that opens, the process object for the “bEL1004_Ch4” BOOL-type variable can be selected
from the PLC configuration tree:



Commissioning

EM2042 37Version: 3.1

Fig. 26: Selecting BOOL-type PDO

According to the default setting, only certain PDO objects are now available for selection. In this example,
the input of channel 4 of the EL1004 terminal is selected for linking. In contrast, the checkbox “All types”
must be ticked to create the link for the output variables, in order to allocate a set of eight separate output
bits to a byte variable in this case. The following diagram shows the whole process:

Fig. 27: Selecting several PDOs simultaneously: activate “Continuous” and “All types”

Note that the “Continuous” checkbox was also activated. This is designed to allocate the bits contained in the
byte of the “nEL2008_value” variable sequentially to all eight selected output bits of the EL2008 Terminal. It
is thus possible to subsequently address all eight outputs of the terminal in the program with a byte
corresponding to bit 0 for channel 1 to bit 7 for channel 8 of the PLC. A special symbol ( ) on the yellow or
red object of the variable indicates that a link exists. The links can also be checked by selecting “Goto Link
Variable” from the context menu of a variable. The opposite linked object, in this case the PDO, is
automatically selected:



Commissioning

EM204238 Version: 3.1

Fig. 28: Application of a “Goto Link Variable”, using “MAIN.bEL1004_Ch4” as an example

The process of assigning variables to the PDO is completed via the menu option “Actions” → “Create

assignment”, or via .

This can be visualized in the configuration:

The process of creating links can also be performed in the opposite direction, i.e. starting with individual
PDOs to a variable. However, in this example, it would not be possible to select all output bits for the
EL2008, since the terminal only makes individual digital outputs available. If a terminal has a byte, word,
integer or similar PDO, it is also possible to allocate this to a set of bit-standardized variables. Here, too, a
“Goto Link Variable” can be executed in the other direction, so that the respective PLC instance can then be
selected.

Activation of the configuration

The allocation of PDO to PLC variables has now established the connection from the controller to the inputs
and outputs of the terminals. The configuration can now be activated. First, the configuration can be verified

via  (or via “Actions” → “Check Configuration”). If no error is present, the configuration can be

activated via  (or via “Actions” → “Activate Configuration…”) to transfer the System Manager settings
to the runtime system. Confirm the messages “Old configurations will be overwritten!” and “Restart TwinCAT
system in Run mode” with “OK”.

A few seconds later, the real-time status  is displayed at the bottom right in the System Manager.
The PLC system can then be started as described below.

Starting the controller

Starting from a remote system, the PLC control has to be linked with the embedded PC over the Ethernet via
“Online” → “Choose Runtime System…”:
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Fig. 29: Choose target system (remote)

In this example, “Runtime system 1 (port 801)” is selected and confirmed. Link the PLC with the real-time

system via the menu option “Online” → “Login”, the F11 key or by clicking on the symbol . The control
program can then be loaded for execution. This results in the message “No program on the controller!
Should the new program be loaded?”, which should be confirmed with “Yes”. The runtime environment is
ready for the program start:
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Fig. 30: PLC Control logged in, ready for program startup

The PLC can now be started via “Online” → “Run”, F5 key or .

4.1.2 TwinCAT 3

Startup

TwinCAT 3 makes the development environment areas available all together, with Microsoft Visual Studio:
after startup, the project folder explorer appears on the left in the general window area (see “TwinCAT
System Manager” of TwinCAT 2) for communication with the electromechanical components.

After successful installation of the TwinCAT system on the PC to be used for development, TwinCAT 3
(shell) displays the following user interface after startup:
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Fig. 31: Initial TwinCAT 3 user interface

First create a new project via  (or under “File”→“New”→ “Project…”). In the
following dialog, make the corresponding entries as required (as shown in the diagram):

Fig. 32: Create new TwinCAT 3 project

The new project is then available in the project folder explorer:
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Fig. 33: New TwinCAT 3 project in the project folder explorer

Generally, TwinCAT can be used in local or remote mode. Once the TwinCAT system including the user
interface (standard) is installed on the respective PLC (locally), TwinCAT can be used in local mode and the
process can be continued with the next step, “Insert Device [} 43]”.

If the intention is to address the TwinCAT runtime environment installed on a PLC remotely from another
system used as a development environment, the target system must be made known first. Via the symbol in
the menu bar:

expand the pull-down menu:

and open the following window:

Fig. 34: Selection dialog: Choose the target system
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Use “Search (Ethernet)...” to enter the target system. Thus another dialog opens to either:

• enter the known computer name after “Enter Host Name / IP:” (as shown in red)
• perform a “Broadcast Search” (if the exact computer name is not known)
• enter the known computer – IP or AmsNetID

Fig. 35: specify the PLC for access by the TwinCAT System Manager: selection of the target system

Once the target system has been entered, it is available for selection as follows (the correct password may
have to be entered beforehand):

After confirmation with “OK” the target system can be accessed via the Visual Studio shell.

Adding devices

In the project folder explorer on the left of the Visual Studio shell user interface, select “Devices” within the

element “I/O”, then right-click to open a context menu and select “Scan” or start the action via  in the

menu bar. The TwinCAT System Manager may first have to be set to “Config mode” via  or via the
menu “TwinCAT” → “Restart TwinCAT (Config Mode)”.

Fig. 36: Select “Scan”

Confirm the warning message, which follows, and select the “EtherCAT” devices in the dialog:
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Fig. 37: Automatic detection of I/O devices: selection of the devices to be integrated

Confirm the message “Find new boxes”, in order to determine the terminals connected to the devices. “Free
Run” enables manipulation of input and output values in “Config Mode” and should also be acknowledged.

Based on the example configuration [} 28] described at the beginning of this section, the result is as follows:

Fig. 38: Mapping of the configuration in VS shell of the TwinCAT 3 environment

The whole process consists of two stages, which can also be performed separately (first determine the
devices, then determine the connected elements such as boxes, terminals, etc.). A scan (search function)
can also be initiated by selecting “Device ...” from the context menu, which then only reads the elements
below which are present in the configuration:
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Fig. 39: Reading of individual terminals connected to a device

This functionality is useful if the actual configuration is modified at short notice.

Programming the PLC

TwinCAT PLC Control is the development environment for generating the controller in different program
environments: TwinCAT PLC Control supports all languages described in IEC 61131-3. There are two text-
based languages and three graphical languages.

• Text-based languages
◦ Instruction List (IL)
◦ Structured Text (ST)

• Graphical languages
◦ Function Block Diagram (FBD)
◦ Ladder Diagram (LD)
◦ The Continuous Function Chart Editor (CFC)
◦ Sequential Function Chart (SFC)

The following section refers solely to Structured Text (ST).

In order to create a programming environment, a PLC subproject is added to the example project via the
context menu of the “PLC” in the project folder explorer by selecting “Add New Item….”:
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Fig. 40: Adding the programming environment in “PLC”

In the dialog that opens, select “Standard PLC project” and enter “PLC_example” as project name, for
example, and select a corresponding directory:

Fig. 41: Specifying the name and directory for the PLC programming environment

The “Main” program, which already exists due to selecting “Standard PLC project”, can be opened by
double-clicking on “PLC_example_project” in “POUs”. The following user interface is shown for an initial
project:
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Fig. 42: Initial “Main” program for the standard PLC project

Now example variables and an example program have been created for the next stage of the process:
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Fig. 43: Example program with variables after a compile process (without variable integration)

The control program is now created as a project folder, followed by the compile process:

Fig. 44: Start program compilation

The following variables, identified in the ST/PLC program with “AT%”, are then available under
“Assignments” in the project folder explorer:

Assigning variables

Via the menu of an instance – variables in the “PLC” context, use the “Modify Link…” option to open a
window to select a suitable process object (PDO) for linking:
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Fig. 45: Creating the links between PLC variables and process objects

In the window that opens, the process object for the “bEL1004_Ch4” BOOL-type variable can be selected
from the PLC configuration tree:

Fig. 46: Selecting BOOL-type PDO

According to the default setting, only certain PDO objects are now available for selection. In this example,
the input of channel 4 of the EL1004 terminal is selected for linking. In contrast, the checkbox “All types”
must be ticked to create the link for the output variables, in order to allocate a set of eight separate output
bits to a byte variable in this case. The following diagram shows the whole process:
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Fig. 47: Selecting several PDOs simultaneously: activate “Continuous” and “All types”

Note that the “Continuous” checkbox was also activated. This is designed to allocate the bits contained in the
byte of the “nEL2008_value” variable sequentially to all eight selected output bits of the EL2008 Terminal. It
is thus possible to subsequently address all eight outputs of the terminal in the program with a byte
corresponding to bit 0 for channel 1 to bit 7 for channel 8 of the PLC. A special symbol ( ) on the yellow or
red object of the variable indicates that a link exists. The links can also be checked by selecting “Goto Link
Variable” from the context menu of a variable. The opposite linked object, in this case the PDO, is
automatically selected:

Fig. 48: Application of a “Goto Link Variable”, using “MAIN.bEL1004_Ch4” as an example

The process of creating links can also be performed in the opposite direction, i.e. starting with individual
PDOs to a variable. However, in this example, it would not be possible to select all output bits for the
EL2008, since the terminal only makes individual digital outputs available. If a terminal has a byte, word,
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integer or similar PDO, it is also possible to allocate this to a set of bit-standardized variables. Here, too, a
“Goto Link Variable” can be executed in the other direction, so that the respective PLC instance can then be
selected.

Note on type of variable assignment
The following type of variable assignment can only be used from TwinCAT version V3.1.4024.4
onwards and is only available for terminals with a microcontroller.

In TwinCAT, a structure can be created from the mapped process data of a terminal. An instance of this
structure can then be created in the PLC, so it is possible to access the process data directly from the PLC
without having to declare own variables.

The procedure for the EL3001 1-channel analog input terminal -10...+10 V is shown as an example.

1. First, the required process data must be selected in the “Process data” tab in TwinCAT.
2. After that, the PLC data type must be generated in the “PLC” tab via the check box.
3. The data type in the “Data Type” field can then be copied using the “Copy” button.

Fig. 49: Creating a PLC data type

4. An instance of the data structure of the copied data type must then be created in the PLC.

Fig. 50: Instance_of_struct

5. Then the project folder must be created. This can be done either via the key combination “CTRL +
Shift + B” or via the “Build” tab in TwinCAT.

6. The structure in the “PLC” tab of the terminal must then be linked to the created instance.
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Fig. 51: Linking the structure

7. In the PLC, the process data can then be read or written via the structure in the program code.

Fig. 52: Reading a variable from the structure of the process data

Activation of the configuration

The allocation of PDO to PLC variables has now established the connection from the controller to the inputs

and outputs of the terminals. The configuration can now be activated with  or via the menu under
“TwinCAT” in order to transfer the settings of the development environment to the runtime system. Confirm
the messages “Old configurations will be overwritten!” and “Restart TwinCAT system in Run mode” with
“OK”. The corresponding assignments can be seen in the project folder explorer:

A few seconds later, the corresponding status of the Run mode is displayed in the form of a rotating symbol

 at the bottom right of the VS shell development environment. The PLC system can then be started as
described below.



Commissioning

EM2042 53Version: 3.1

Starting the controller

Select the menu option “PLC” → “Login” or click on  to link the PLC with the real-time system and load
the control program for execution. This results in the message ”No program on the controller! Should the
new program be loaded?”, which should be acknowledged with “Yes”. The runtime environment is ready for

the program to be started by clicking on symbol , the “F5” key or via “PLC” in the menu, by selecting
“Start”. The started programming environment shows the runtime values of individual variables:

Fig. 53: TwinCAT 3 development environment (VS shell): logged-in, after program startup

The two operator control elements for stopping  and logout  result in the required action (also,
“Shift + F5” can be used for stop, or both actions can be selected via the PLC menu).

4.2 TwinCAT Development Environment
The Software for automation TwinCAT (The Windows Control and Automation Technology) will be
distinguished into:

• TwinCAT 2: System Manager (Configuration) & PLC Control (Programming)
• TwinCAT 3: Enhancement of TwinCAT 2 (Programming and Configuration takes place via a common

Development Environment)

Details:
• TwinCAT 2:

◦ Connects I/O devices to tasks in a variable-oriented manner
◦ Connects tasks to tasks in a variable-oriented manner
◦ Supports units at the bit level
◦ Supports synchronous or asynchronous relationships
◦ Exchange of consistent data areas and process images
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◦ Datalink on NT - Programs by open Microsoft Standards (OLE, OCX, ActiveX, DCOM+, etc.)
◦ Integration of IEC 61131-3-Software-SPS, Software- NC and Software-CNC within Windows NT/

2000/XP/Vista, Windows 7, NT/XP Embedded, CE
◦ Interconnection to all common fieldbusses

◦ More…

Additional features:
• TwinCAT 3 (eXtended Automation):

◦ Visual Studio® integration
◦ Choice of the programming language
◦ Supports object orientated extension of IEC 61131-3
◦ Usage of C/C++ as programming language for real time applications
◦ Connection to MATLAB®/Simulink®
◦ Open interface for expandability
◦ Flexible run-time environment
◦ Active support of multi-core- and 64 bit operating system
◦ Automatic code generation and project creation with the TwinCAT Automation Interface

◦ More…

Within the following sections commissioning of the TwinCAT Development Environment on a PC System for
the control and also the basically functions of unique control elements will be explained.

Please see further information to TwinCAT 2 and TwinCAT 3 at http://infosys.beckhoff.com.

4.2.1 Installation of the TwinCAT real-time driver
In order to assign real-time capability to a standard Ethernet port of an IPC controller, the Beckhoff real-time
driver has to be installed on this port under Windows.

This can be done in several ways.

A: Via the TwinCAT Adapter dialog

In the System Manager call up the TwinCAT overview of the local network interfaces via Options → Show
Real Time Ethernet Compatible Devices.

Fig. 54: System Manager “Options” (TwinCAT 2)

This have to be called up by the menu “TwinCAT” within the TwinCAT 3 environment:

http://infosys.beckhoff.com
http://infosys.beckhoff.com
http://infosys.beckhoff.com
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Fig. 55: Call up under VS Shell (TwinCAT 3)

B: Via TcRteInstall.exe in the TwinCAT directory

Fig. 56: TcRteInstall in the TwinCAT directory

In both cases, the following dialog appears:
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Fig. 57: Overview of network interfaces

Interfaces listed under “Compatible devices” can be assigned a driver via the “Install” button. A driver should
only be installed on compatible devices.

A Windows warning regarding the unsigned driver can be ignored.

Alternatively an EtherCAT-device can be inserted first of all as described in chapter Offline configuration
creation, section “Creating the EtherCAT device” [} 65] in order to view the compatible ethernet ports via its
EtherCAT properties (tab “Adapter”, button “Compatible Devices…”):

Fig. 58: EtherCAT device properties (TwinCAT 2): click on “Compatible Devices…” of tab “Adapter”

TwinCAT 3: the properties of the EtherCAT device can be opened by double click on “Device .. (EtherCAT)”
within the Solution Explorer under “I/O”:

After the installation the driver appears activated in the Windows overview for the network interface
(Windows Start → System Properties → Network)
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Fig. 59: Windows properties of the network interface

A correct setting of the driver could be:

Fig. 60: Exemplary correct driver setting for the Ethernet port

Other possible settings have to be avoided:
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Fig. 61: Incorrect driver settings for the Ethernet port
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IP address of the port used

IP address/DHCP
In most cases an Ethernet port that is configured as an EtherCAT device will not transport general
IP packets. For this reason and in cases where an EL6601 or similar devices are used it is useful to
specify a fixed IP address for this port via the “Internet Protocol TCP/IP” driver setting and to disable
DHCP. In this way the delay associated with the DHCP client for the Ethernet port assigning itself a
default IP address in the absence of a DHCP server is avoided. A suitable address space is
192.168.x.x, for example.

Fig. 62: TCP/IP setting for the Ethernet port
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4.2.2 Notes regarding ESI device description

Installation of the latest ESI device description

The TwinCAT EtherCAT master/System Manager needs the device description files for the devices to be
used in order to generate the configuration in online or offline mode. The device descriptions are contained
in the so-called ESI files (EtherCAT Slave Information) in XML format. These files can be requested from the
respective manufacturer and are made available for download. An *.xml file may contain several device
descriptions.

The ESI files for Beckhoff EtherCAT devices are available on the Beckhoff website.

The ESI files should be stored in the TwinCAT installation directory.

Default settings:

• TwinCAT 2: C:\TwinCAT\IO\EtherCAT
• TwinCAT 3: C:\TwinCAT\3.1\Config\Io\EtherCAT

The files are read (once) when a new System Manager window is opened, if they have changed since the
last time the System Manager window was opened.

A TwinCAT installation includes the set of Beckhoff ESI files that was current at the time when the TwinCAT
build was created.

For TwinCAT 2.11/TwinCAT 3 and higher, the ESI directory can be updated from the System Manager, if the
programming PC is connected to the Internet; by

• TwinCAT 2: Option → “Update EtherCAT Device Descriptions”
• TwinCAT 3: TwinCAT → EtherCAT Devices → “Update Device Descriptions (via ETG Website)…”

The TwinCAT ESI Updater [} 64] is available for this purpose.

ESI
The *.xml files are associated with *.xsd files, which describe the structure of the ESI XML files. To
update the ESI device descriptions, both file types should therefore be updated.

Device differentiation

EtherCAT devices/slaves are distinguished by four properties, which determine the full device identifier. For
example, the device identifier EL2521-0025-1018 consists of:

• family key “EL”
• name “2521”
• type “0025”
• and revision “1018”

Fig. 63: Identifier structure

The order identifier consisting of name + type (here: EL2521-0010) describes the device function. The
revision indicates the technical progress and is managed by Beckhoff. In principle, a device with a higher
revision can replace a device with a lower revision, unless specified otherwise, e.g. in the documentation.
Each revision has its own ESI description. See further notes [} 9].

https://download.beckhoff.com/download/configuration-files/io/ethercat/xml-device-description/Beckhoff_EtherCAT_XML.zip
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Online description

If the EtherCAT configuration is created online through scanning of real devices (see section Online setup)
and no ESI descriptions are available for a slave (specified by name and revision) that was found, the
System Manager asks whether the description stored in the device should be used. In any case, the System
Manager needs this information for setting up the cyclic and acyclic communication with the slave correctly.

Fig. 64: OnlineDescription information window (TwinCAT 2)

In TwinCAT 3 a similar window appears, which also offers the Web update:

Fig. 65: Information window OnlineDescription (TwinCAT 3)

If possible, the Yes is to be rejected and the required ESI is to be requested from the device manufacturer.
After installation of the XML/XSD file the configuration process should be repeated.

NOTICE
Changing the “usual” configuration through a scan
ü If a scan discovers a device that is not yet known to TwinCAT, distinction has to be made between two

cases. Taking the example here of the EL2521-0000 in the revision 1019
a) no ESI is present for the EL2521-0000 device at all, either for the revision 1019 or for an older revision.

The ESI must then be requested from the manufacturer (in this case Beckhoff).
b) an ESI is present for the EL2521-0000 device, but only in an older revision, e.g. 1018 or 1017.

In this case an in-house check should first be performed to determine whether the spare parts stock
allows the integration of the increased revision into the configuration at all. A new/higher revision usually
also brings along new features. If these are not to be used, work can continue without reservations with
the previous revision 1018 in the configuration. This is also stated by the Beckhoff compatibility rule.

Refer in particular to the chapter “General notes on the use of Beckhoff EtherCAT IO components” and for
manual configuration to the chapter “Offline configuration creation [} 65]”.

If the OnlineDescription is used regardless, the System Manager reads a copy of the device description from
the EEPROM in the EtherCAT slave. In complex slaves the size of the EEPROM may not be sufficient for the
complete ESI, in which case the ESI would be incomplete in the configurator. Therefore it’s recommended
using an offline ESI file with priority in such a case.

The System Manager creates for online recorded device descriptions a new file
“OnlineDescription0000...xml” in its ESI directory, which contains all ESI descriptions that were read online.

http://infosys.beckhoff.com/content/1033/ethercatsystem/2469088779.html
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Fig. 66: File OnlineDescription.xml created by the System Manager

Is a slave desired to be added manually to the configuration at a later stage, online created slaves are
indicated by a prepended symbol “>” in the selection list (see Figure Indication of an online recorded ESI of
EL2521 as an example).

Fig. 67: Indication of an online recorded ESI of EL2521 as an example

If such ESI files are used and the manufacturer's files become available later, the file OnlineDescription.xml
should be deleted as follows:

• close all System Manager windows
• restart TwinCAT in Config mode
• delete “OnlineDescription0000...xml”
• restart TwinCAT System Manager

This file should not be visible after this procedure, if necessary press <F5> to update

OnlineDescription for TwinCAT 3.x
In addition to the file described above “OnlineDescription0000...xml”, a so called EtherCAT cache
with new discovered devices is created by TwinCAT 3.x, e.g. under Windows 7:

(Please note the language settings of the OS!)
You have to delete this file, too.

Faulty ESI file

If an ESI file is faulty and the System Manager is unable to read it, the System Manager brings up an
information window.

Fig. 68: Information window for faulty ESI file (left: TwinCAT 2; right: TwinCAT 3)
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Reasons may include:

• Structure of the *.xml does not correspond to the associated *.xsd file → check your schematics
• Contents cannot be translated into a device description → contact the file manufacturer
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4.2.3 TwinCAT ESI Updater
For TwinCAT 2.11 and higher, the System Manager can search for current Beckhoff ESI files automatically, if
an online connection is available:

Fig. 69: Using the ESI Updater (>= TwinCAT 2.11)

The call up takes place under:
“Options” → “Update EtherCAT Device Descriptions”

Selection under TwinCAT 3:

Fig. 70: Using the ESI Updater (TwinCAT 3)

The ESI Updater (TwinCAT 3) is a convenient option for automatic downloading of ESI data provided by
EtherCAT manufacturers via the Internet into the TwinCAT directory (ESI = EtherCAT slave information).
TwinCAT accesses the central ESI ULR directory list stored at ETG; the entries can then be viewed in the
Updater dialog, although they cannot be changed there.

The call up takes place under:
“TwinCAT” → “EtherCAT Devices” → “Update Device Description (via ETG Website)…”.

4.2.4 Distinction between Online and Offline
The distinction between online and offline refers to the presence of the actual I/O environment (drives,
terminals, EJ-modules). If the configuration is to be prepared in advance of the system configuration as a
programming system, e.g. on a laptop, this is only possible in “Offline configuration” mode. In this case all
components have to be entered manually in the configuration, e.g. based on the electrical design.

If the designed control system is already connected to the EtherCAT system and all components are
energised and the infrastructure is ready for operation, the TwinCAT configuration can simply be generated
through “scanning” from the runtime system. This is referred to as online configuration.

In any case, during each startup the EtherCAT master checks whether the slaves it finds match the
configuration. This test can be parameterised in the extended slave settings. Refer to note “Installation of
the latest ESI-XML device description” [} 60].

For preparation of a configuration:
• the real EtherCAT hardware (devices, couplers, drives) must be present and installed
• the devices/modules must be connected via EtherCAT cables or in the terminal/ module strand in the

same way as they are intended to be used later
• the devices/modules be connected to the power supply and ready for communication
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• TwinCAT must be in CONFIG mode on the target system.

The online scan process consists of:

• detecting the EtherCAT device [} 70] (Ethernet port at the IPC)

• detecting the connected EtherCAT devices [} 71]. This step can be carried out independent of the
preceding step

• troubleshooting [} 74]

The scan with existing configuration [} 75] can also be carried out for comparison.

4.2.5 OFFLINE configuration creation

Creating the EtherCAT device

Create an EtherCAT device in an empty System Manager window.

Fig. 71: Append EtherCAT device (left: TwinCAT 2; right: TwinCAT 3)

Select type “EtherCAT” for an EtherCAT I/O application with EtherCAT slaves. For the present publisher/
subscriber service in combination with an EL6601/EL6614 terminal select “EtherCAT Automation Protocol
via EL6601”.

Fig. 72: Selecting the EtherCAT connection (TwinCAT 2.11, TwinCAT 3)

Then assign a real Ethernet port to this virtual device in the runtime system.

Fig. 73: Selecting the Ethernet port
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This query may appear automatically when the EtherCAT device is created, or the assignment can be set/
modified later in the properties dialog; see Fig. “EtherCAT device properties (TwinCAT 2)”.

Fig. 74: EtherCAT device properties (TwinCAT 2)

TwinCAT 3: the properties of the EtherCAT device can be opened by double click on “Device .. (EtherCAT)”
within the Solution Explorer under “I/O”:

Selecting the Ethernet port
Ethernet ports can only be selected for EtherCAT devices for which the TwinCAT real-time driver is
installed. This has to be done separately for each port. Please refer to the respective installation
page [} 54].

Defining EtherCAT slaves

Further devices can be appended by right-clicking on a device in the configuration tree.

Fig. 75: Appending EtherCAT devices (left: TwinCAT 2; right: TwinCAT 3)

The dialog for selecting a new device opens. Only devices for which ESI files are available are displayed.

Only devices are offered for selection that can be appended to the previously selected device. Therefore, the
physical layer available for this port is also displayed (Fig. “Selection dialog for new EtherCAT device”, A). In
the case of cable-based Fast-Ethernet physical layer with PHY transfer, then also only cable-based devices
are available, as shown in Fig. “Selection dialog for new EtherCAT device”. If the preceding device has
several free ports (e.g. EK1122 or EK1100), the required port can be selected on the right-hand side (A).

Overview of physical layer

• “Ethernet”: cable-based 100BASE-TX: couplers, box modules, devices with RJ45/M8/M12 connector
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• “E-Bus”: LVDS “terminal bus”, EtherCAT plug-in modules (EJ), EtherCAT terminals (EL/ES), various
modular modules

The search field facilitates finding specific devices (since TwinCAT 2.11 or TwinCAT 3).

Fig. 76: Selection dialog for new EtherCAT device

By default, only the name/device type is used as selection criterion. For selecting a specific revision of the
device, the revision can be displayed as “Extended Information”.

Fig. 77: Display of device revision

In many cases several device revisions were created for historic or functional reasons, e.g. through
technological advancement. For simplification purposes (see Fig. “Selection dialog for new EtherCAT
device”) only the last (i.e. highest) revision and therefore the latest state of production is displayed in the
selection dialog for Beckhoff devices. To show all device revisions available in the system as ESI
descriptions tick the “Show Hidden Devices” check box, see Fig. “Display of previous revisions”.
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Fig. 78: Display of previous revisions

Device selection based on revision, compatibility
The ESI description also defines the process image, the communication type between master and
slave/device and the device functions, if applicable. The physical device (firmware, if available) has
to support the communication queries/settings of the master. This is backward compatible, i.e.
newer devices (higher revision) should be supported if the EtherCAT master addresses them as an
older revision. The following compatibility rule of thumb is to be assumed for Beckhoff EtherCAT
Terminals/ Boxes/ EJ-modules:
device revision in the system >= device revision in the configuration
This also enables subsequent replacement of devices without changing the configuration (different
specifications are possible for drives).

Example

If an EL2521-0025-1018 is specified in the configuration, an EL2521-0025-1018 or higher (-1019, -1020) can
be used in practice.

Fig. 79: Name/revision of the terminal

If current ESI descriptions are available in the TwinCAT system, the last revision offered in the selection
dialog matches the Beckhoff state of production. It is recommended to use the last device revision when
creating a new configuration, if current Beckhoff devices are used in the real application. Older revisions
should only be used if older devices from stock are to be used in the application.

In this case the process image of the device is shown in the configuration tree and can be parameterized as
follows: linking with the task, CoE/DC settings, plug-in definition, startup settings, ...



Commissioning

EM2042 69Version: 3.1

Fig. 80: EtherCAT terminal in the TwinCAT tree (left: TwinCAT 2; right: TwinCAT 3)
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4.2.6 ONLINE configuration creation

Detecting/scanning of the EtherCAT device

The online device search can be used if the TwinCAT system is in CONFIG mode. This can be indicated by
a symbol right below in the information bar:

• on TwinCAT 2 by a blue display “Config Mode” within the System Manager window: .

• on TwinCAT 3 within the user interface of the development environment by a symbol .

TwinCAT can be set into this mode:

• TwinCAT 2: by selection of  in the Menubar or by “Actions” → “Set/Reset TwinCAT to Config
Mode…”

• TwinCAT 3: by selection of  in the Menubar or by “TwinCAT” → “Restart TwinCAT (Config Mode)”

Online scanning in Config mode
The online search is not available in RUN mode (production operation). Note the differentiation
between TwinCAT programming system and TwinCAT target system.

The TwinCAT 2 icon ( ) or TwinCAT 3 icon ( ) within the Windows-Taskbar always shows the
TwinCAT mode of the local IPC. Compared to that, the System Manager window of TwinCAT 2 or the user
interface of TwinCAT 3 indicates the state of the target system.

Fig. 81: Differentiation local/target system (left: TwinCAT 2; right: TwinCAT 3)

Right-clicking on “I/O Devices” in the configuration tree opens the search dialog.

Fig. 82: Scan Devices (left: TwinCAT 2; right: TwinCAT 3)

This scan mode attempts to find not only EtherCAT devices (or Ethernet ports that are usable as such), but
also NOVRAM, fieldbus cards, SMB etc. However, not all devices can be found automatically.

Fig. 83: Note for automatic device scan (left: TwinCAT 2; right: TwinCAT 3)
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Ethernet ports with installed TwinCAT real-time driver are shown as “RT Ethernet” devices. An EtherCAT
frame is sent to these ports for testing purposes. If the scan agent detects from the response that an
EtherCAT slave is connected, the port is immediately shown as an “EtherCAT Device” .

Fig. 84: Detected Ethernet devices

Via respective checkboxes devices can be selected (as illustrated in Fig. “Detected Ethernet devices” e.g.
Device 3 and Device 4 were chosen). After confirmation with “OK” a device scan is suggested for all selected
devices, see Fig.: “Scan query after automatic creation of an EtherCAT device”.

Selecting the Ethernet port
Ethernet ports can only be selected for EtherCAT devices for which the TwinCAT real-time driver is
installed. This has to be done separately for each port. Please refer to the respective installation
page [} 54].

Detecting/Scanning the EtherCAT devices

Online scan functionality
During a scan the master queries the identity information of the EtherCAT slaves from the slave
EEPROM. The name and revision are used for determining the type. The respective devices are
located in the stored ESI data and integrated in the configuration tree in the default state defined
there.

Fig. 85: Example default state

NOTICE
Slave scanning in practice in series machine production
The scanning function should be used with care. It is a practical and fast tool for creating an initial
configuration as a basis for commissioning. In series machine production or reproduction of the plant,
however, the function should no longer be used for the creation of the configuration, but if necessary for
comparison [} 75] with the defined initial configuration.Background: since Beckhoff occasionally increases
the revision version of the delivered products for product maintenance reasons, a configuration can be
created by such a scan which (with an identical machine construction) is identical according to the device
list; however, the respective device revision may differ from the initial configuration.

Example:

Company A builds the prototype of a machine B, which is to be produced in series later on. To do this the
prototype is built, a scan of the IO devices is performed in TwinCAT and the initial configuration “B.tsm” is
created. The EL2521-0025 EtherCAT terminal with the revision 1018 is located somewhere. It is thus built
into the TwinCAT configuration in this way:
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Fig. 86: Installing EthetCAT terminal with revision -1018

Likewise, during the prototype test phase, the functions and properties of this terminal are tested by the
programmers/commissioning engineers and used if necessary, i.e. addressed from the PLC “B.pro” or the
NC. (the same applies correspondingly to the TwinCAT 3 solution files).

The prototype development is now completed and series production of machine B starts, for which Beckhoff
continues to supply the EL2521-0025-0018. If the commissioning engineers of the series machine production
department always carry out a scan, a B configuration with the identical contents results again for each
machine. Likewise, A might create spare parts stores worldwide for the coming series-produced machines
with EL2521-0025-1018 terminals.

After some time Beckhoff extends the EL2521-0025 by a new feature C. Therefore the FW is changed,
outwardly recognizable by a higher FW version and a new revision -1019. Nevertheless the new device
naturally supports functions and interfaces of the predecessor version(s); an adaptation of “B.tsm” or even
“B.pro” is therefore unnecessary. The series-produced machines can continue to be built with “B.tsm” and
“B.pro”; it makes sense to perform a comparative scan [} 75] against the initial configuration “B.tsm” in order
to check the built machine.

However, if the series machine production department now doesn’t use “B.tsm”, but instead carries out a
scan to create the productive configuration, the revision -1019 is automatically detected and built into the
configuration:

Fig. 87: Detection of EtherCAT terminal with revision -1019

This is usually not noticed by the commissioning engineers. TwinCAT cannot signal anything either, since
virtually a new configuration is created. According to the compatibility rule, however, this means that no
EL2521-0025-1018 should be built into this machine as a spare part (even if this nevertheless works in the
vast majority of cases).

In addition, it could be the case that, due to the development accompanying production in company A, the
new feature C of the EL2521-0025-1019 (for example, an improved analog filter or an additional process
data for the diagnosis) is discovered and used without in-house consultation. The previous stock of spare
part devices are then no longer to be used for the new configuration “B2.tsm” created in this way. Þ if series
machine production is established, the scan should only be performed for informative purposes for
comparison with a defined initial configuration. Changes are to be made with care!

If an EtherCAT device was created in the configuration (manually or through a scan), the I/O field can be
scanned for devices/slaves.

Fig. 88: Scan query after automatic creation of an EtherCAT device (left: TwinCAT 2; right: TwinCAT 3)
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Fig. 89: Manual triggering of a device scan on a specified EtherCAT device (left: TwinCAT 2; right:
TwinCAT 3)

In the System Manager (TwinCAT 2) or the User Interface (TwinCAT 3) the scan process can be monitored
via the progress bar at the bottom in the status bar.

Fig. 90: Scan progressexemplary by TwinCAT 2

The configuration is established and can then be switched to online state (OPERATIONAL).

Fig. 91: Config/FreeRun query (left: TwinCAT 2; right: TwinCAT 3)

In Config/FreeRun mode the System Manager display alternates between blue and red, and the EtherCAT
device continues to operate with the idling cycle time of 4 ms (default setting), even without active task (NC,
PLC).

Fig. 92: Displaying of “Free Run” and “Config Mode” toggling right below in the status bar

Fig. 93: TwinCAT can also be switched to this state by using a button (left: TwinCAT 2; right: TwinCAT 3)

The EtherCAT system should then be in a functional cyclic state, as shown in Fig. Online display example.
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Fig. 94: Online display example

Please note:

• all slaves should be in OP state
• the EtherCAT master should be in “Actual State” OP
• “frames/sec” should match the cycle time taking into account the sent number of frames
• no excessive “LostFrames” or CRC errors should occur

The configuration is now complete. It can be modified as described under manual procedure [} 65].

Troubleshooting

Various effects may occur during scanning.

• An unknown device is detected, i.e. an EtherCAT slave for which no ESI XML description is available.
In this case the System Manager offers to read any ESI that may be stored in the device. This case is
described in the chapter “Notes regarding ESI device description”.

• Device are not detected properly
Possible reasons include:

◦ faulty data links, resulting in data loss during the scan
◦ slave has invalid device description

The connections and devices should be checked in a targeted manner, e.g. via the emergency
scan.
Then re-run the scan.

Fig. 95: Faulty identification

In the System Manager such devices may be set up as EK0000 or unknown devices. Operation is not
possible or meaningful.
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Scan over existing Configuration

NOTICE
Change of the configuration after comparison
With this scan (TwinCAT 2.11 or 3.1) only the device properties vendor (manufacturer), device name and
revision are compared at present! A “ChangeTo” or “Copy” should only be carried out with care, taking into
consideration the Beckhoff IO compatibility rule (see above). The device configuration is then replaced by
the revision found; this can affect the supported process data and functions.

If a scan is initiated for an existing configuration, the actual I/O environment may match the configuration
exactly or it may differ. This enables the configuration to be compared.

Fig. 96: Identical configuration (left: TwinCAT 2; right: TwinCAT 3)

If differences are detected, they are shown in the correction dialog, so that the user can modify the
configuration as required.

Fig. 97: Correction dialog

It is advisable to tick the “Extended Information” check box to reveal differences in the revision.
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Color Explanation
green This EtherCAT slave matches the entry on the other side. Both type and revision match.
blue This EtherCAT slave is present on the other side, but in a different revision. This other revision can

have other default values for the process data as well as other/additional functions.
If the found revision is higher than the configured revision, the slave may be used provided
compatibility issues are taken into account.
If the found revision is lower than the configured revision, it is likely that the slave cannot be used.
The found device may not support all functions that the master expects based on the higher
revision number.

light
blue

This EtherCAT slave is ignored (“Ignore” button)

red • This EtherCAT slave is not present on the other side.
• It is present, but in a different revision, which also differs in its properties from the one specified.

The compatibility principle then also applies here: if the found revision is higher than the config-
ured revision, use is possible provided compatibility issues are taken into account, since the
successor devices should support the functions of the predecessor devices. 
If the found revision is lower than the configured revision, it is likely that the slave cannot be
used. The found device may not support all functions that the master expects based on the
higher revision number.

Device selection based on revision, compatibility
The ESI description also defines the process image, the communication type between master and
slave/device and the device functions, if applicable. The physical device (firmware, if available) has
to support the communication queries/settings of the master. This is backward compatible, i.e.
newer devices (higher revision) should be supported if the EtherCAT master addresses them as an
older revision. The following compatibility rule of thumb is to be assumed for Beckhoff EtherCAT
Terminals/ Boxes/ EJ-modules:
device revision in the system >= device revision in the configuration
This also enables subsequent replacement of devices without changing the configuration (different
specifications are possible for drives).

Example

If an EL2521-0025-1018 is specified in the configuration, an EL2521-0025-1018 or higher (-1019, -1020) can
be used in practice.

Fig. 98: Name/revision of the terminal

If current ESI descriptions are available in the TwinCAT system, the last revision offered in the selection
dialog matches the Beckhoff state of production. It is recommended to use the last device revision when
creating a new configuration, if current Beckhoff devices are used in the real application. Older revisions
should only be used if older devices from stock are to be used in the application.

In this case the process image of the device is shown in the configuration tree and can be parameterized as
follows: linking with the task, CoE/DC settings, plug-in definition, startup settings, ...
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Fig. 99: Correction dialog with modifications

Once all modifications have been saved or accepted, click “OK” to transfer them to the real *.tsm
configuration.

Change to Compatible Type

TwinCAT offers a function Change to Compatible Type… for the exchange of a device whilst retaining the
links in the task.

Fig. 100: Dialog “Change to Compatible Type…” (left: TwinCAT 2; right: TwinCAT 3)

The following elements in the ESI of an EtherCAT device are compared by TwinCAT and assumed to be the
same in order to decide whether a device is indicated as "compatible":

- Physics (e.g. RJ45, Ebus...)

- FMMU (additional ones are allowed)

- SyncManager (SM, additional ones are allowed)

- EoE (attributes MAC, IP)

- CoE (attributes SdoInfo, PdoAssign, PdoConfig, PdoUpload, CompleteAccess)

- FoE

- PDO (process data: Sequence, SyncUnit SU, SyncManager SM, EntryCount, Ent-ry.Datatype)

This function is preferably to be used on AX5000 devices.

Change to Alternative Type

The TwinCAT System Manager offers a function for the exchange of a device: Change to Alternative Type



Commissioning

EM204278 Version: 3.1

Fig. 101: TwinCAT 2 Dialog Change to Alternative Type

If called, the System Manager searches in the procured device ESI (in this example: EL1202-0000) for
details of compatible devices contained there. The configuration is changed and the ESI-EEPROM is
overwritten at the same time – therefore this process is possible only in the online state (ConfigMode).

4.2.7 EtherCAT subscriber configuration
In the left-hand window of the TwinCAT 2 System Manager or the Solution Explorer of the TwinCAT 3
Development Environment respectively, click on the element of the terminal within the tree you wish to
configure (in the example: EL3751 Terminal 3).

Fig. 102: Branch element as terminal EL3751

In the right-hand window of the TwinCAT System Manager (TwinCAT 2) or the Development Environment
(TwinCAT 3), various tabs are now available for configuring the terminal. And yet the dimension of
complexity of a subscriber determines which tabs are provided. Thus as illustrated in the example above the
terminal EL3751 provides many setup options and also a respective number of tabs are available. On the
contrary by the terminal EL1004 for example the tabs “General”, “EtherCAT”, “Process Data” and “Online“
are available only. Several terminals, as for instance the EL6695 provide special functions by a tab with its
own terminal name, so “EL6695” in this case. A specific tab “Settings” by terminals with a wide range of
setup options will be provided also (e.g. EL3751).

“General” tab

Fig. 103: “General” tab
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Name Name of the EtherCAT device
Id Number of the EtherCAT device
Type EtherCAT device type
Comment Here you can add a comment (e.g. regarding the system).
Disabled Here you can deactivate the EtherCAT device.
Create symbols Access to this EtherCAT slave via ADS is only available if this control box is

activated.

“EtherCAT” tab

Fig. 104: “EtherCAT” tab

Type EtherCAT device type
Product/Revision Product and revision number of the EtherCAT device
Auto Inc Addr. Auto increment address of the EtherCAT device. The auto increment address can

be used for addressing each EtherCAT device in the communication ring through
its physical position. Auto increment addressing is used during the start-up phase
when the EtherCAT master allocates addresses to the EtherCAT devices. With
auto increment addressing the first EtherCAT slave in the ring has the address
0000hex. For each further slave the address is decremented by 1 (FFFFhex, FFFEhex
etc.).

EtherCAT Addr. Fixed address of an EtherCAT slave. This address is allocated by the EtherCAT
master during the start-up phase. Tick the control box to the left of the input field in
order to modify the default value.

Previous Port Name and port of the EtherCAT device to which this device is connected. If it is
possible to connect this device with another one without changing the order of the
EtherCAT devices in the communication ring, then this combination field is
activated and the EtherCAT device to which this device is to be connected can be
selected.

Advanced Settings This button opens the dialogs for advanced settings.

The link at the bottom of the tab points to the product page for this EtherCAT device on the web.

“Process Data” tab

Indicates the configuration of the process data. The input and output data of the EtherCAT slave are
represented as CANopen process data objects (Process Data Objects, PDOs). The user can select a PDO
via PDO assignment and modify the content of the individual PDO via this dialog, if the EtherCAT slave
supports this function.
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Fig. 105: “Process Data” tab

The process data (PDOs) transferred by an EtherCAT slave during each cycle are user data which the
application expects to be updated cyclically or which are sent to the slave. To this end the EtherCAT master
(Beckhoff TwinCAT) parameterizes each EtherCAT slave during the start-up phase to define which process
data (size in bits/bytes, source location, transmission type) it wants to transfer to or from this slave. Incorrect
configuration can prevent successful start-up of the slave.

For Beckhoff EtherCAT EL, ES, EM, EJ and EP slaves the following applies in general:

• The input/output process data supported by the device are defined by the manufacturer in the ESI/XML
description. The TwinCAT EtherCAT Master uses the ESI description to configure the slave correctly.

• The process data can be modified in the System Manager. See the device documentation.
Examples of modifications include: mask out a channel, displaying additional cyclic information, 16-bit
display instead of 8-bit data size, etc.

• In so-called “intelligent” EtherCAT devices the process data information is also stored in the CoE
directory. Any changes in the CoE directory that lead to different PDO settings prevent successful
startup of the slave. It is not advisable to deviate from the designated process data, because the
device firmware (if available) is adapted to these PDO combinations.

If the device documentation allows modification of process data, proceed as follows (see Figure Configuring
the process data).

• A: select the device to configure
• B: in the “Process Data” tab select Input or Output under SyncManager (C)
• D: the PDOs can be selected or deselected
• H: the new process data are visible as linkable variables in the System Manager

The new process data are active once the configuration has been activated and TwinCAT has been
restarted (or the EtherCAT master has been restarted)

• E: if a slave supports this, Input and Output PDO can be modified simultaneously by selecting a so-
called PDO record (“predefined PDO settings”).
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Fig. 106: Configuring the process data

Manual modification of the process data
According to the ESI description, a PDO can be identified as “fixed” with the flag “F” in the PDO
overview (Fig. Configuring the process data, J). The configuration of such PDOs cannot be
changed, even if TwinCAT offers the associated dialog (“Edit”). In particular, CoE content cannot be
displayed as cyclic process data. This generally also applies in cases where a device supports
download of the PDO configuration, “G”. In case of incorrect configuration the EtherCAT slave
usually refuses to start and change to OP state. The System Manager displays an “invalid SM cfg”
logger message: This error message (“invalid SM IN cfg” or “invalid SM OUT cfg”) also indicates the
reason for the failed start.

A detailed description [} 86] can be found at the end of this section.

“Startup” tab

The Startup tab is displayed if the EtherCAT slave has a mailbox and supports the CANopen over EtherCAT
(CoE) or Servo drive over EtherCAT protocol. This tab indicates which download requests are sent to the
mailbox during startup. It is also possible to add new mailbox requests to the list display. The download
requests are sent to the slave in the same order as they are shown in the list.
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Fig. 107: “Startup” tab

Column Description
Transition Transition to which the request is sent. This can either be

• the transition from pre-operational to safe-operational (PS), or
• the transition from safe-operational to operational (SO).
If the transition is enclosed in “<>” (e.g. <PS>), the mailbox request is fixed and cannot be
modified or deleted by the user.

Protocol Type of mailbox protocol
Index Index of the object
Data Date on which this object is to be downloaded.
Comment Description of the request to be sent to the mailbox

Move Up This button moves the selected request up by one position in the list.
Move Down This button moves the selected request down by one position in the list.
New This button adds a new mailbox download request to be sent during startup.
Delete This button deletes the selected entry.
Edit This button edits an existing request.

“CoE - Online” tab

The additional CoE - Online tab is displayed if the EtherCAT slave supports the CANopen over EtherCAT
(CoE) protocol. This dialog lists the content of the object list of the slave (SDO upload) and enables the user
to modify the content of an object from this list. Details for the objects of the individual EtherCAT devices can
be found in the device-specific object descriptions.
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Fig. 108: “CoE - Online” tab

Object list display

Column Description
Index Index and sub-index of the object
Name Name of the object
Flags RW The object can be read, and data can be written to the object (read/write)

RO The object can be read, but no data can be written to the object (read only)
P An additional P identifies the object as a process data object.

Value Value of the object

Update List The Update list button updates all objects in the displayed list
Auto Update If this check box is selected, the content of the objects is updated automatically.
Advanced The Advanced button opens the Advanced Settings dialog. Here you can specify which

objects are displayed in the list.
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Fig. 109: Dialog “Advanced settings”

Online - via SDO Information If this option button is selected, the list of the objects included in the object
list of the slave is uploaded from the slave via SDO information. The list
below can be used to specify which object types are to be uploaded.

Offline - via EDS File If this option button is selected, the list of the objects included in the object
list is read from an EDS file provided by the user.

“Online” tab

Fig. 110: “Online” tab
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State Machine

Init This button attempts to set the EtherCAT device to the Init state.
Pre-Op This button attempts to set the EtherCAT device to the pre-operational state.
Op This button attempts to set the EtherCAT device to the operational state.
Bootstrap This button attempts to set the EtherCAT device to the Bootstrap state.
Safe-Op This button attempts to set the EtherCAT device to the safe-operational state.
Clear Error This button attempts to delete the fault display. If an EtherCAT slave fails during

change of state it sets an error flag.
Example: An EtherCAT slave is in PREOP state (pre-operational). The master now
requests the SAFEOP state (safe-operational). If the slave fails during change of
state it sets the error flag. The current state is now displayed as ERR PREOP.
When the Clear Error button is pressed the error flag is cleared, and the current
state is displayed as PREOP again.

Current State Indicates the current state of the EtherCAT device.
Requested State Indicates the state requested for the EtherCAT device.

DLL Status

Indicates the DLL status (data link layer status) of the individual ports of the EtherCAT slave. The DLL status
can have four different states:

Status Description
No Carrier / Open No carrier signal is available at the port, but the port is open.
No Carrier / Closed No carrier signal is available at the port, and the port is closed.
Carrier / Open A carrier signal is available at the port, and the port is open.
Carrier / Closed A carrier signal is available at the port, but the port is closed.

File Access over EtherCAT

Download With this button a file can be written to the EtherCAT device.
Upload With this button a file can be read from the EtherCAT device.

“DC” tab (Distributed Clocks)

Fig. 111: “DC” tab (Distributed Clocks)

Operation Mode Options (optional):
• FreeRun
• SM-Synchron
• DC-Synchron (Input based)
• DC-Synchron

Advanced Settings… Advanced settings for readjustment of the real time determinant TwinCAT-clock

Detailed information to Distributed Clocks is specified on http://infosys.beckhoff.com:

Fieldbus Components → EtherCAT Terminals → EtherCAT System documentation → EtherCAT basics →
Distributed Clocks

http://infosys.beckhoff.com
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4.2.7.1 Detailed description of Process Data tab

Sync Manager

Lists the configuration of the Sync Manager (SM).
If the EtherCAT device has a mailbox, SM0 is used for the mailbox output (MbxOut) and SM1 for the mailbox
input (MbxIn).
SM2 is used for the output process data (outputs) and SM3 (inputs) for the input process data.

If an input is selected, the corresponding PDO assignment is displayed in the PDO Assignment list below.

PDO Assignment

PDO assignment of the selected Sync Manager. All PDOs defined for this Sync Manager type are listed
here:

• If the output Sync Manager (outputs) is selected in the Sync Manager list, all RxPDOs are displayed.
• If the input Sync Manager (inputs) is selected in the Sync Manager list, all TxPDOs are displayed.

The selected entries are the PDOs involved in the process data transfer. In the tree diagram of the System
Manager these PDOs are displayed as variables of the EtherCAT device. The name of the variable is
identical to the Name parameter of the PDO, as displayed in the PDO list. If an entry in the PDO assignment
list is deactivated (not selected and greyed out), this indicates that the input is excluded from the PDO
assignment. In order to be able to select a greyed out PDO, the currently selected PDO has to be deselected
first.

Activation of PDO assignment
ü If you have changed the PDO assignment, in order to activate the new PDO assignment,
a) the EtherCAT slave has to run through the PS status transition cycle (from pre-operational to

safe-operational) once (see Online tab [} 84]),
b) and the System Manager has to reload the EtherCAT slaves

(  button for TwinCAT 2 or  button for TwinCAT 3)

PDO list

List of all PDOs supported by this EtherCAT device. The content of the selected PDOs is displayed in the
PDO Content list. The PDO configuration can be modified by double-clicking on an entry.

Column Description
Index PDO index.
Size Size of the PDO in bytes.
Name Name of the PDO.

If this PDO is assigned to a Sync Manager, it appears as a variable of the slave with this
parameter as the name.

Flags F Fixed content: The content of this PDO is fixed and cannot be changed by the
System Manager.

M Mandatory PDO. This PDO is mandatory and must therefore be assigned to a
Sync Manager! Consequently, this PDO cannot be deleted from the PDO
Assignment list

SM Sync Manager to which this PDO is assigned. If this entry is empty, this PDO does not take
part in the process data traffic.

SU Sync unit to which this PDO is assigned.

PDO Content

Indicates the content of the PDO. If flag F (fixed content) of the PDO is not set the content can be modified.
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Download

If the device is intelligent and has a mailbox, the configuration of the PDO and the PDO assignments can be
downloaded to the device. This is an optional feature that is not supported by all EtherCAT slaves.

PDO Assignment

If this check box is selected, the PDO assignment that is configured in the PDO Assignment list is
downloaded to the device on startup. The required commands to be sent to the device can be viewed in the
Startup [} 81] tab.

PDO Configuration

If this check box is selected, the configuration of the respective PDOs (as shown in the PDO list and the
PDO Content display) is downloaded to the EtherCAT slave.

4.2.8 Import/Export of EtherCAT devices with SCI and XTI

SCI and XTI Export/Import – Handling of user-defined modified EtherCAT slaves

4.2.8.1 Basic principles
An EtherCAT slave is basically parameterized through the following elements:

• Cyclic process data (PDO)
• Synchronization (Distributed Clocks, FreeRun, SM-Synchron)
• CoE parameters (acyclic object dictionary)

Note: Not all three elements may be present, depending on the slave.

For a better understanding of the export/import function, let's consider the usual procedure for IO
configuration:

• The user/programmer processes the IO configuration in the TwinCAT system environment. This
involves all input/output devices such as drives that are connected to the fieldbuses used.
Note: In the following sections, only EtherCAT configurations in the TwinCAT system environment are
considered.

• For example, the user manually adds devices to a configuration or performs a scan on the online
system.

• This results in the IO system configuration.
• On insertion, the slave appears in the system configuration in the default configuration provided by the

vendor, consisting of default PDO, default synchronization method and CoE StartUp parameter as
defined in the ESI (XML device description).

• If necessary, elements of the slave configuration can be changed, e.g. the PDO configuration or the
synchronization method, based on the respective device documentation.

It may become necessary to reuse the modified slave in other projects in this way, without having to make
equivalent configuration changes to the slave again. To accomplish this, proceed as follows:

• Export the slave configuration from the project,
• Store and transport as a file,
• Import into another EtherCAT project.

TwinCAT offers two methods for this purpose:

• within the TwinCAT environment: Export/Import as xti file or
• outside, i.e. beyond the TwinCAT limits: Export/Import as sci file.

An example is provided below for illustration purposes: an EL3702 terminal with standard setting is switched
to 2-fold oversampling (blue) and the optional PDO "StartTimeNextLatch" is added (red):
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The two methods for exporting and importing the modified terminal referred to above are demonstrated
below.

4.2.8.2 Procedure within TwinCAT with xti files
Each IO device can be exported/saved individually:

The xti file can be stored:

and imported again in another TwinCAT system via "Insert Existing item":
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4.2.8.3 Procedure within and outside TwinCAT with sci file
Note regarding availability (2021/01)

The SCI method is available from TwinCAT 3.1 build 4024.14.

The Slave Configuration Information (SCI) describes a specific complete configuration for an EtherCAT slave
(terminal, box, drive...) based on the setting options of the device description file (ESI, EtherCAT Slave
Information). That is, it includes PDO, CoE, synchronization.

Export:
• select a single device via the menu (multiple selection is also possible):

TwinCAT → EtherCAT Devices → Export SCI.

• If TwinCAT is offline (i.e. if there is no connection to an actual running controller) a warning message
may appear, because after executing the function the system attempts to reload the EtherCAT
segment. However, in this case this is not relevant for the result and can be acknowledged by clicking
OK:
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• A description may also be provided:

• Explanation of the dialog box:

Name Name of the SCI, assigned by the user.
Description Description of the slave configuration for the use case, assigned by the user.
Options Keep modules If a slave supports modules/slots, the user can decide whether these are to be exported or

whether the module and device data are to be combined during export.
AoE | Set AmsNetId The configured AmsNetId is exported. Usually this is network-dependent and cannot

always be determined in advance.
EoE | Set MAC and IP The configured virtual MAC and IP addresses are stored in the SCI. Usually these are

network-dependent and cannot always be determined in advance.
CoE | Set cycle
time(0x1C3x.2)

The configured cycle time is exported. Usually this is network-dependent and cannot
always be determined in advance.

ESI Reference to the original ESI file.
Export Save SCI file.

• A list view is available for multiple selections (Export multiple SCI files):

• Selection of the slaves to be exported:
◦ All:

All slaves are selected for export.
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◦ None:
All slaves are deselected.

• The sci file can be saved locally:

• The export takes place:

Import
• An sci description can be inserted manually into the TwinCAT configuration like any normal Beckhoff

device description.
• The sci file must be located in the TwinCAT ESI path, usually under:

C:\TwinCAT\3.1\Config\Io\EtherCAT

• Open the selection dialog:
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• Display SCI devices and select and insert the desired device:

Additional Notes
• Settings for the SCI function can be made via the general Options dialog

(Tools → Options → TwinCAT → Export SCI):

Explanation of the settings:

Default export
options

AoE | Set AmsNetId Default setting whether the configured AmsNetId is exported.
CoE | Set cycle time(0x1C3x.2) Default setting whether the configured cycle time is exported.
EoE | Set MAC and IP Default setting whether the configured MAC and IP addresses are exported.
Keep modules Default setting whether the modules persist.

Generic Reload Devices Setting whether the Reload Devices command is executed before the SCI
export.
This is strongly recommended to ensure a consistent slave configuration.
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SCI error messages are displayed in the TwinCAT logger output window if required:

4.3 General Commissioning Instructions for an EtherCAT
Slave

This summary briefly deals with a number of aspects of EtherCAT Slave operation under TwinCAT. More
detailed information on this may be found in the corresponding sections of, for instance, the  EtherCAT
System Documentation.

Diagnosis in real time: WorkingCounter, EtherCAT State and Status

Generally speaking an EtherCAT Slave provides a variety of diagnostic information that can be used by the
controlling task.

This diagnostic information relates to differing levels of communication. It therefore has a variety of sources,
and is also updated at various times.

Any application that relies on I/O data from a fieldbus being correct and up to date must make diagnostic
access to the corresponding underlying layers. EtherCAT and the TwinCAT System Manager offer
comprehensive diagnostic elements of this kind. Those diagnostic elements that are helpful to the controlling
task for diagnosis that is accurate for the current cycle when in operation (not during commissioning) are
discussed below.

Fig. 112: Selection of the diagnostic information of an EtherCAT Slave

In general, an EtherCAT Slave offers

• communication diagnosis typical for a slave (diagnosis of successful participation in the exchange of
process data, and correct operating mode)
This diagnosis is the same for all slaves.

as well as
• function diagnosis typical for a channel (device-dependent)

See the corresponding device documentation

The colors in Fig. Selection of the diagnostic information of an EtherCAT Slave also correspond to the
variable colors in the System Manager, see Fig. Basic EtherCAT Slave Diagnosis in the PLC.

https://infosys.beckhoff.com/content/1033/ethercatsystem/index.html
https://infosys.beckhoff.com/content/1033/ethercatsystem/index.html
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Colour Meaning
yellow Input variables from the Slave to the EtherCAT Master, updated in every cycle
red Output variables from the Slave to the EtherCAT Master, updated in every cycle
green Information variables for the EtherCAT Master that are updated acyclically. This means that

it is possible that in any particular cycle they do not represent the latest possible status. It is
therefore useful to read such variables through ADS.

Fig. Basic EtherCAT Slave Diagnosis in the PLC shows an example of an implementation of basic EtherCAT
Slave Diagnosis. A Beckhoff EL3102 (2-channel analogue input terminal) is used here, as it offers both the
communication diagnosis typical of a slave and the functional diagnosis that is specific to a channel.
Structures are created as input variables in the PLC, each corresponding to the process image.

Fig. 113: Basic EtherCAT Slave Diagnosis in the PLC

The following aspects are covered here:
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Code Function Implementation Application/evaluation
A The EtherCAT Master's diagnostic

information
updated acyclically (yellow) or provided
acyclically (green).

At least the DevState is to be evaluated for
the most recent cycle in the PLC.
The EtherCAT Master's diagnostic
information offers many more possibilities
than are treated in the EtherCAT System
Documentation. A few keywords:

• CoE in the Master for communication
with/through the Slaves

• Functions from TcEtherCAT.lib

• Perform an OnlineScan
B In the example chosen (EL3102) the

EL3102 comprises two analogue input
channels that transmit a single function
status for the most recent cycle.

Status
• the bit significations may be

found in the device
documentation

• other devices may supply
more information, or none that
is typical of a slave

In order for the higher-level PLC task (or
corresponding control applications) to be
able to rely on correct data, the function
status must be evaluated there. Such
information is therefore provided with the
process data for the most recent cycle.

C For every EtherCAT Slave that has cyclic
process data, the Master displays, using
what is known as a WorkingCounter,
whether the slave is participating
successfully and without error in the cyclic
exchange of process data. This important,
elementary information is therefore
provided for the most recent cycle in the
System Manager

1. at the EtherCAT Slave, and, with
identical contents

2. as a collective variable at the
EtherCAT Master (see Point A)

for linking.

WcState (Working Counter)
0: valid real-time communication in
the last cycle
1: invalid real-time communication
This may possibly have effects on
the process data of other Slaves
that are located in the same
SyncUnit

In order for the higher-level PLC task (or
corresponding control applications) to be
able to rely on correct data, the
communication status of the EtherCAT Slave
must be evaluated there. Such information is
therefore provided with the process data for
the most recent cycle.

D Diagnostic information of the EtherCAT
Master which, while it is represented at the
slave for linking, is actually determined by
the Master for the Slave concerned and
represented there. This information cannot
be characterized as real-time, because it

• is only rarely/never changed, except
when the system starts up

• is itself determined acyclically (e.g.
EtherCAT Status)

State
current Status (INIT..OP) of the
Slave. The Slave must be in OP
(=8) when operating normally.
AdsAddr

The ADS address is useful for
communicating from the PLC/task
via ADS with the EtherCAT Slave,
e.g. for reading/writing to the CoE.
The AMS-NetID of a slave
corresponds to the AMS-NetID of
the EtherCAT Master;
communication with the individual
Slave is possible via the port (=
EtherCAT address).

Information variables for the EtherCAT
Master that are updated acyclically. This
means that it is possible that in any particular
cycle they do not represent the latest
possible status. It is therefore possible to
read such variables through ADS.

NOTICE
Diagnostic information
It is strongly recommended that the diagnostic information made available is evaluated so that the
application can react accordingly.

CoE Parameter Directory

The CoE parameter directory (CanOpen-over-EtherCAT) is used to manage the set values for the slave
concerned. Changes may, in some circumstances, have to be made here when commissioning a relatively
complex EtherCAT Slave. It can be accessed through the TwinCAT System Manager, see Fig. EL3102, CoE
directory:
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Fig. 114: EL3102, CoE directory

EtherCAT System Documentation
The comprehensive description in the EtherCAT System Documentation (EtherCAT Basics --> CoE
Interface) must be observed!

A few brief extracts:

• Whether changes in the online directory are saved locally in the slave depends on the device. EL
terminals (except the EL66xx) are able to save in this way.

• The user must manage the changes to the StartUp list.

Commissioning aid in the TwinCAT System Manager

Commissioning interfaces are being introduced as part of an ongoing process for EL/EP EtherCAT devices.
These are available in TwinCAT System Managers from TwinCAT 2.11R2 and above. They are integrated
into the System Manager through appropriately extended ESI configuration files.

https://infosys.beckhoff.com/content/1033/ethercatsystem/index.html
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Fig. 115: Example of commissioning aid for a EL3204

This commissioning process simultaneously manages

• CoE Parameter Directory
• DC/FreeRun mode
• the available process data records (PDO)

Although the “Process Data”, “DC”, “Startup” and “CoE-Online” that used to be necessary for this are still
displayed, it is recommended that, if the commissioning aid is used, the automatically generated settings are
not changed by it.

The commissioning tool does not cover every possible application of an EL/EP device. If the available setting
options are not adequate, the user can make the DC, PDO and CoE settings manually, as in the past.

EtherCAT State: automatic default behaviour of the TwinCAT System Manager and manual operation

After the operating power is switched on, an EtherCAT Slave must go through the following statuses

• INIT
• PREOP
• SAFEOP
• OP

to ensure sound operation. The EtherCAT Master directs these statuses in accordance with the initialization
routines that are defined for commissioning the device by the ES/XML and user settings (Distributed Clocks
(DC), PDO, CoE). See also the section on "Principles of Communication, EtherCAT State Machine [} 101]" in
this connection. Depending how much configuration has to be done, and on the overall communication,
booting can take up to a few seconds.

The EtherCAT Master itself must go through these routines when starting, until it has reached at least the
OP target state.

The target state wanted by the user, and which is brought about automatically at start-up by TwinCAT, can
be set in the System Manager. As soon as TwinCAT reaches the status RUN, the TwinCAT EtherCAT
Master will approach the target states.
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Standard setting

The advanced settings of the EtherCAT Master are set as standard:

• EtherCAT Master: OP
• Slaves: OP

This setting applies equally to all Slaves.

Fig. 116: Default behaviour of the System Manager

In addition, the target state of any particular Slave can be set in the “Advanced Settings” dialogue; the
standard setting is again OP.

Fig. 117: Default target state in the Slave

Manual Control

There are particular reasons why it may be appropriate to control the states from the application/task/PLC.
For instance:

• for diagnostic reasons
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• to induce a controlled restart of axes
• because a change in the times involved in starting is desirable

In that case it is appropriate in the PLC application to use the PLC function blocks from the TcEtherCAT.lib,
which is available as standard, and to work through the states in a controlled manner using, for instance,
FB_EcSetMasterState.

It is then useful to put the settings in the EtherCAT Master to INIT for master and slave.

Fig. 118: PLC function blocks

Note regarding E-Bus current

EL/ES terminals are placed on the DIN rail at a coupler on the terminal strand. A Bus Coupler can supply the
EL terminals added to it with the E-bus system voltage of 5 V; a coupler is thereby loadable up to 2 A as a
rule. Information on how much current each EL terminal requires from the E-bus supply is available online
and in the catalogue. If the added terminals require more current than the coupler can supply, then power
feed terminals (e.g. EL9410) must be inserted at appropriate places in the terminal strand.

The pre-calculated theoretical maximum E-Bus current is displayed in the TwinCAT System Manager as a
column value. A shortfall is marked by a negative total amount and an exclamation mark; a power feed
terminal is to be placed before such a position.
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Fig. 119: Illegally exceeding the E-Bus current

From TwinCAT 2.11 and above, a warning message “E-Bus Power of Terminal...” is output in the logger
window when such a configuration is activated:

Fig. 120: Warning message for exceeding E-Bus current

NOTICE
Caution! Malfunction possible!
The same ground potential must be used for the E-Bus supply of all EtherCAT terminals in a terminal block!
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4.4 EtherCAT State Machine
The state of the EtherCAT slave is controlled via the EtherCAT State Machine (ESM). Depending upon the
state, different functions are accessible or executable in the EtherCAT slave. Specific commands must be
sent by the EtherCAT master to the device in each state, particularly during the bootup of the slave.

A distinction is made between the following states:

• Init
• Pre-Operational
• Safe-Operational and
• Operational
• Boot

The regular state of each EtherCAT slave after bootup is the OP state.

Fig. 121: States of the EtherCAT State Machine

Init

After switch-on the EtherCAT slave in the Init state. No mailbox or process data communication is possible.
The EtherCAT master initializes sync manager channels 0 and 1 for mailbox communication.

Pre-Operational (Pre-Op)

During the transition between Init and Pre-Op the EtherCAT slave checks whether the mailbox was initialized
correctly.

In Pre-Op state mailbox communication is possible, but not process data communication. The EtherCAT
master initializes the sync manager channels for process data (from sync manager channel 2), the FMMU
channels and, if the slave supports configurable mapping, PDO mapping or the sync manager PDO
assignment. In this state the settings for the process data transfer and perhaps terminal-specific parameters
that may differ from the default settings are also transferred.

Safe-Operational (Safe-Op)

During transition between Pre-Op and Safe-Op the EtherCAT slave checks whether the sync manager
channels for process data communication and, if required, the distributed clocks settings are correct. Before
it acknowledges the change of state, the EtherCAT slave copies current input data into the associated DP-
RAM areas of the EtherCAT slave controller (ECSC).
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In Safe-Op state mailbox and process data communication is possible, although the slave keeps its outputs
in a safe state, while the input data are updated cyclically.

Outputs in SAFEOP state
The default set watchdog monitoring sets the outputs of the module in a safe state - depending on
the settings in SAFEOP and OP - e.g. in OFF state. If this is prevented by deactivation of the
watchdog monitoring in the module, the outputs can be switched or set also in the SAFEOP state.

Operational (Op)

Before the EtherCAT master switches the EtherCAT slave from Safe-Op to Op it must transfer valid output
data.

In the Op state the slave copies the output data of the masters to its outputs. Process data and mailbox
communication is possible.

Boot

In the Boot state the slave firmware can be updated. The Boot state can only be reached via the Init state.

In the Boot state mailbox communication via the file access over EtherCAT (FoE) protocol is possible, but no
other mailbox communication and no process data communication.
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5 Appendix

5.1 Support and Service
Beckhoff and their partners around the world offer comprehensive support and service, making available fast
and competent assistance with all questions related to Beckhoff products and system solutions.

Beckhoff's branch offices and representatives

Please contact your Beckhoff branch office or representative for local support and service on Beckhoff
products!

The addresses of Beckhoff's branch offices and representatives round the world can be found on her internet
pages: www.beckhoff.com

You will also find further documentation for Beckhoff components there.

Support

The Beckhoff Support offers you comprehensive technical assistance, helping you not only with the
application of individual Beckhoff products, but also with other, wide-ranging services:

• support
• design, programming and commissioning of complex automation systems
• and extensive training program for Beckhoff system components

Hotline: +49 5246 963 157
e-mail: support@beckhoff.com
web: www.beckhoff.com/support

Service

The Beckhoff Service Center supports you in all matters of after-sales service:

• on-site service
• repair service
• spare parts service
• hotline service

Hotline: +49 5246 963 460
e-mail: service@beckhoff.com
web: www.beckhoff.com/service

Headquarters Germany

Beckhoff Automation GmbH & Co. KG

Hülshorstweg 20
33415 Verl
Germany

Phone: +49 5246 963 0
e-mail: info@beckhoff.com
web: www.beckhoff.com

https://www.beckhoff.com/
https://www.beckhoff.com/support
https://www.beckhoff.com/service
https://www.beckhoff.com/
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